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2 A TR AR 2.1 BT TR

2 R TIRER

21 B @ERETIE
2.1.1 BB ETE

T EF: “New” (1) B8 “File > New > C Project”, &
2-1 FizRo

1. #@rmiH AR E A

BT H KA “Empty Project”;

3. EFmiE 1 H%E “RISC-V Cross GCC”;
4. Fii “Next”.

2-1 IERETEE

{Ar C Project O *

N

C Project —

Create C project of selected type

Project name: |gowin_picorv32

Use default location

D:AGMD_workspace\workspace_risovigowin_picorv32 Browse...
default
Project type: Tocolchains:

~ (= Executable ~ ARM Cross GCC
& Empty Project ]
& Hello World ARM C Projec
& Hello World RISC-V C Proj
(= Shared Library
[Z= Static Library

L

W

< >

Show project types and toolchains only if they are supported on the platform

S~ _ .
L\?/' = Back Mext = Einish Cancel

IPUG910-1.5 2(20)




2 AT AR

2.1 BT TR

2.1.2 EFFEARE
L5254 “Debug” 1 “Release”, H.ifi “Next”, 1l 2-2 Fizx.

& 2-2 ixFEFH AR

W C Project O
Select Configurations

Select platforms and configurations you wish to deploy on

Project type:  Executable
Toolchains: RISC-V Cross GCC

Configurations:

3 Debug

Select all
# Release

Deselect all

Use "Advanced settings" button to edit project's properties.

Additional configurations can be added after project creation.
Use "Manage configurations” buttons either on toclbar or on property pages.

l:?:' < Back . Next = Finish Cancel

Advanced settings...

2.1.3 EFRIFT REMEE
%6 4w % T B 5% riscv-none-embed-gcc K HFTAE IR, BERAAL B

IPUG910-1.5

Toolchain name #1 Toolchain path, #.i; “Finish”, tn&l 2-3 fs.

IR TR EAE ] B g X RISC-V 4 T HABE, WIEB IR & 9 i LB

LAz
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214 BB TIRE

IPUG910-1.5

B 2-3 IEFgmiF T AR

W C Project O X

GMU RISC-V Cross Toolchain —

Select the toolchain and configure path

Toalchain name: |GNU MCU RISC-V GCC (riscv-nane-embed-gec) v|

Toolchain path: | DAGMD'\toolchain\RISC-V_toolchainibin Browse...

Next = Finish Cancel

S8R TR , 7E Project Explorer 1 didk #8111 H TR,
BN LREEERAIARAY, B Nt .

DA R TRASH R ], BATgfE it I H TR LA E
a1 N R

bsp: ARV £ IR B BUE X

lib:

simpleuart.h

simpleuart.c: 444 Simple UART 3Kz sk $5E X
wbgpio.h

wbgpio.c: 4N GPIO W3k %iE X
wbi2c.h

wbi2c.c: AT A 12C JRB) R HE L

wbspi.h

wbspi.c: FMB# % SPI KB R EE X
wbspiflash.h

wbspiflash.c: 4154 SPI-Flash 3Xzh & $E X
wbuart.h

wbuart.c: #MHB R UART X3 ek 40 X
RGEEE X

firmware.h
firmware.c: &4i15 EE X

4(20)




2 AT AR

2.2 g B B TR

- printf.c: HE X printf %L
config.h: HI /L & JE 2h fig 1777 1
custom_ops.S: H/ 4 E X

irg.h
irq.c: T EAR T

loader.c: Ja3h77 = X

main.c: F /7 F KL

picorv32.h: WL ZF 7. Ml MU E

start.S: JEah5 S E X

sections_debug.lds: T AR 8EEE

sections_xip.lds: Fi T4 SPI-Flash iz 17484 14
sections.lds: T B ITCM B1TFE 5462 1 B2
BRI E AR A AR T, 1S ELE] “Project Explorer” ik

ECURTHAE TR, 47k “Refresh”, B HrkEgwmfe it i g THE.

22 BERHTIE

TERLE“ Project Explorer v, 1L 41 B LA, 47 i B Properties >

C/C++ Build > Settings > Tool Settings” £, FE X4 HTH 4 LIRS Huk

i,

Gowin_PicoRV32 W, Zillic B LA N S 4%k i :
Target Processor

Optimization

GNU RISC-V Cross C Compiler

- Includes

GNU RISC-V Cross C Linker

- General

GNU RISC-V Cross Create Flash Image
- General

2.2.1 BCE Target Processor

IPUG910-1.5

FC#E “Target Processor” iET, i%IEIACE, WK 2-4 fls.
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2 AT AR

2.2 g B B TR

[& 2-4 it E Target Processor

i Tool Settings & Toolchains M Devices

(# Target Processor

(& Optimization
(% Warnings
(% Debugging
v B3 GNU RISC-V Cross Assembler
(# Preprocessor
(# Includes
(# Warnings
(# Miscellaneous
v & GNU RISC-V Cross C Compiler
(& Preprocessor
(2 Includes
(& Optimization
(% Warnings
(& Miscellaneous
~ B3 GNU RISC-V Cross C Linker
(% General
(% Libraries
(# Miscellaneous
v B3 GNU RISC-V Cross Create Flash Image
(# General
v B3 GNU RISC-V Cross Create Listing
(# General
v &3 GNU RISC-V Cross Print Size
(# General

® Architecture

Wik RV32I(-march=rv32i*),

Build Steps Build Artifact [u) Binary Parsers @  * | *

Architecture RV32I (-march=rv32i%)

Multiply extension (RVM)

[ Atomic extension (RVA)
Floating point None

[ Compressed extension (RVC)
Integer ABI ILP32 (-mabi=ilp32*)
Floating point ABI |None

Tuning Size (-mtune=size)

Code model Medium Any (-mcmodel=medany)

Small data limit 8

Align Strict (-mstrict-align)
Small prologue/epilogue (-msave-restore)

Force string operations to call library functions (-mmemcp

Other target flags

Gowin_PicoRV32 ¥ 57 #f RISC-V32 {1

BSR4, BT LR RV321 ZET,

® Multiply extension (RVM)

WRTFEMH RV32M §7 &, 1718 Multiply extension(RVM)iE£T. [F]
i 7E Gowin_PicoRV32 {415 it IP Core Generator 1. E [ Gowin
PicoRV32 CORE Z 4t &+, )i Support RV32M Extends i1, 75
2 P05 RISC-V PR ey 4l 21, 22 3 2 Gowin_PicoRV32 iz 1T Hi 1% .

® Atomic extension (RVA)

Gowin_PicoRV32 ASZHF I THE29 i, 15K HIIZEI.

® Floating point

Gowin_PicoRV32 AN HHF 484, 1ZIETiiEIEFE None.

® Compressed extension (RVC)
R T EH H RV32C ¥ &, i 71 /3 Compressed extension (RVC)i& i .
A If 7 Gowin_PicoRV32 {4411 IPCore Generator 1. E.ff] Gowin
PicoRV32 CORE Z#(it & 7, )5 Support RV32C Extends £, 45
W% L RISC-V 16 i E4i 45 2B, 22 55 Gowin_PicoRV32 i 1744

R
® Integer ABI

W B RISC-V HFrF & Fr i ABI &80 F#0. Gowin_PicoRV32

IPUG910-1.5
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N 32 £ RISC-V BRI AL HL B8 T &, EASTRAE(FIF S 54, bz
THIEFE ILP32 (-mabi=ilp32*). 32 {7 RISC-V 4244 kb2 28 £ H5 S8 58 1,
W 2-1 fizs.

= 2-1 32 {if RISC-V b TS HE 2R R

C i 5 Hudla kY 32 fiz RISC-V ZM e R s (Hfiz: 77

char

short

int

long

long long

void *

float

double

oA IN|~

long double

N
(o))

Tuning

Ti 7€ 9w 1= L A BE GCC Ny HLf ALK ERE 1) H AR AL BR AR A4 PR
Gowin_PicoRV32 AN SCRFZIED, 1H5iLH Size(-mtune=size).

Code model

WHEZ4-memodel, ZZHIEEREF T UIERE, % Medium Any
(-mcmodel=medany). (-mcmodel=medany)i% i T-1& & 1% F 1) 5k
VO E A LEAE S 4GB N, FHEERATE, N RiE.
Small data limit

B ZE-msmall-data-limit, %244 € 7] LUBCE B/ N DX 80 4 )
A E AR ERHK Size (L7 ANBAL). ZSHEN 8.

Align

B A 15 I8 G0 A AN 5 AT A B4R E . Gowin_PicoRV32 ANz 7R
BEAERFFUT ], @ ILFE Strict(-mstrict-align).

Small prologue/epilogue(-msave-restore)

WRTF S iZ3k 0, W E AR Size e/ (EIEE F18 A E 4G AR 148
B P B A8 BRI Y A IERARAS

Other target flags &1 H AT LLF-Zhas inin A& -

- Allow use of PLTs(-mplt)
U G B Ak I, U A PLT A b Wrdss il AXA .

- Integer divide instructions(-mdiv)
T R B e T, WU e FH A A i R 4, TF E AR T AR SCRF RV32M
24V & . Gowin_PicoRV32 SZKF RV32M 5 & 4E4 g, Friln] LA
fic & Multiply extension(RVM)i£1i, [F]H7E Gowin_PicoRV32 figif4:
# it IP Core Generator T. E.ff] Gowin PicoRV32 CORE Z (X & ',
JF )& Support RV32M Extends £ i

7(20)
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2.2 B E YA TR

- -mpreferred-stack-boundary=num

I FEXIFE 09 2num TG . ARRARE, WBRIE Y 24 (I

16 FHTEL 128 A) 5%, R B iZIE T,

i BAE 2R I (AR, RGUEARIEEREY .

- -mexplicit-relocs / -mno-exlicit-relocs

SUBEEE %’iﬂjhﬁﬁ? ik Y BN IV G A 15 B [ R A AT o ) — R L

A I 9 %
- -mrelax

- -mno-relax

5 FH BE AR i SR Y3 D SCBLAT 5 ML bk BT 5 (1 98

G2/ A A

Xl e PRI -

- -memit-attribute / -mno-emit-attribute

BRI RISC-V B HE B8 ELF & . %45 52 binutils

2.32 jlAs.

- -malign-data=type
i GCC W 5542 . Zhitfak
FrR2RAUE N “xlen” F1 “natural”. Hr,
YENXTFHE, “natural” fd ) B8 5%,

2.2.2 fig® Optimization

IPUG910-1.5

fid & “Optimization” &I,
[#] 2-5 it ® Optimization

& Tool Settings & Toolchains [ Devices

(2 Target Processor
(22 Optimization

# Warnings

(2 Debugging

wv %) GNU RISC-V Cross Assembler

(% Preprocessor
2 Includes

(# Warnings

(# Miscellaneous

~ B3 GNU RISC-V Cross C Compiler

@ Preprocessor
2 Includes

(# Optimization

= Warnings

(# Miscellaneous

~ 3 GNU RISC-V Cross C Linker

# General
(2 Libraries
(# Miscellaneous

v &3 GNU RISC-V Cross Create Flash Image

(# General

~ 3 GNU RISC-V Cross Create Listing

# General

~ 3 GNU RISC-V Cross Print Size

(# General

PRI E, Kl 2-5 iR

Build Steps Build Artifact [} Binary Parsers @ | ¢ ¢

Optimization Level None (-00) ~
Message length (-fmessage-length=0)

[1'char is signed (-fsigned-char)

Function sections (-ffunction-sections)

[ Data sections (-fdata-sections)

[ONo common unitialized (-fno-common)

[0 Do not inline functions (-fno-inline-functions)

[ Assume freestanding environment (-ffreestanding)
Disable builtin (-fno-builtin)

[JsSingle precision constants (-fsingle-precision-constant)
[1Position independent code (-PIC)

[JLink-time optimizer (-flta)

[]Disable loop invariant move (-fno-move-loop-invariants)

Other optimization flags

VU 7E g 3 P A R

LR BRI A B

PRA RS RT AR E R . 7
“xlen” fifi F ZF {748 %5 5
BRAIME N “xlen”.

8(20)
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Optimization Level

IS -O ek BIAER, DA dm i Size. AT 3 & A 2 BEI ] 55
AR AFE-00. -0O1. -02. -03. -Os. -Og, -00/-01/-02/-03 itk
LR BRI

- -00: At

- -Os: 7£-O2 HyFAl F, S5 34 1% Size B R HILETH, SLILXS 4 1%
Size &AL

- -Og: fE-O0 fy&Eali b, Mm—Leid H T 9w 3iE i, Gowin
_PicoRV32 AR i, PRI g iR Y AR A Ak 50

Message length (-fmessage-length=n)

WA RE B LT n MR RE AR R EER G @ Db R R E R 0,

M2C AT ThRE, — KRG R A—1T . Bl N-fmessage-length=0.

AV R ZI% I

‘char’ is signed (-fsigned-char)

W char KM H AR5 HL

Function sections (-ffunction-sections) / Data sections (-fdata-sections)

- A BERSCRHEE B, WA R eR BB TU7E S S SO A R T R B
(PBE, A5 FH BRS04 BRI T 1) 4 PR A A S B IR 2 K

~ AEEREEER ] DABAT otk de 4 S 1) Hr g | I SRR e e A, T LS e
IR T

- E AR (BERIEE —go-sections iET) —iEfEH, N
Ja A2 BT SIS Bl R Ve A A FH 1 R BB AN B T B, 72 AR B
9mi¥% Size.

V!

RAETERE ™A B3 ORI A P 1%k T, HlCATE “GNU RISC-V Cross C Linker >

General” %I+ ¥ )5 “Remove unused sections (-Xlinker --gc-sections)” %5, LA
WD g Sizeo

No common unitialized (-fno-common)

fno-common 1% I8 € 2 PEAS R AR B A 4 e AR R 3 H AR SO
BSS Btrit. XRFPHIEEERR AR S RE € 3, B RAE 2 g i oo
ST MR B R, W L2 i SRR R IZE T .

Do not inline functions (-fno-inline-functions)

WIRFF R 1ZIE T, MR T £/ always_inline B HEFRICIIRELZ 4b, B
THEAT AR R, BRI E . AT H] noinline J& 1k
PRICEABREL, DL S 1% 2R B IR

Assume freestanding environment (-ffreestanding)

U7 5 48 % BRI B9 —MRSEFRSS, M SIER S AT RE A AERUE R, P
JRBTREAN R E A BE B REBIERGNZ. 2T -fno-hosted.

Disable builtin (-fno-builtin)
- AREBIA L _builtin_YE RIS A B R SRR, AR

9(20)




2 AT AR

2.2 g B B TR

Fi-ansi 8-std & TU(F T ™8 1 1ISO C —E0ME )i A & P B BRI EH) B
#, FONEAH 1ISO FaikE s L.

- GCC ¥ A AR AID K BE A Rt A R L8 oy B ek B, 9, %
alloca ¥ FH AT BEAZ il B R B HERR (W BN 48 4, X memcpy 1
FHRT R AR A BRI o A2 AR I8 W B /N BEER, E2 el T
B A LLX AR 77 sUH I, ANREAE IR LB ] B & Wr ad, ANEE
A T T AN [ ) P K BE SRR B AT

- AN, B ARERER BN E RN, GCC RIRES K Ti%
K15 B R A A ek B ) R, B AR S A RARES, B AR
B AR TS PR A0 S iz s B A o 9, A printf JF H.C 0
strlen AMEM4 R WAERS, 22 F-Wformat 45 Hi Xt printf (852 U8 1)
X

Single precision constants (-fsingle-precision-constant)

W17 R A Dy ORGP AL T

Position independent code (-fPIC)

AR E AR AL SR, AR B A 3L v A ) S 6 B TS R D

(PIC). Gowin_PicoRV32 A3 PIC, #IK AL

- Link-time optimizer (-flto)

A TS AT FR e 1) E B2 I (A AL 25 -

- EREARS AR, A2 GIMPLE (GCC W&~ —) B E
NI G R R ELF 7150 90 GO AE— N, FrA 1
HARAMN ELF S50 B2 OF Sl anfml 2 [F— B e s oo i — &8 7 .

- AEFEE R RS LA G 1 I R A 2% 2 ] 4 i -flto AN AL T,
VAR AR [F) B 1 T 9 22 55 AR [R) JE 35 A0 P A A, AR I 4 72
X LL LT

Disable loop invariant move (-fno-move-loop-invariants)

WP S HUH RTL AL S T BRI AR S A%, HIUSE M E

N-O1 B =554 (-Og FRAb), HBJTE RTL JEAILALE T HITEA A AR

(LU

2.2.3 BgE GNU RISC-V Cross C Compiler > Includes

IPUG910-1.5

it & “GNU RISC-V Cross C Compiler > Includes > Include paths (-1)”

I, IZEIECE C kL5 kAR, Wk 2-6 Fis.

LA K THRAZE R ], C kX5 SR E, 0 F Fix:
"${workspace_loc:/${ProjName}/src}"
"${workspace_loc:/${ProjName}/src/bsp}"
"${workspace_loc:/${ProjName}/src/lib}"

10(20)
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& 2-6 AL E GNU RISC-V Cross C Compiler > Includes

& Tool Settings  H3 Toolchains M Devices # Build Steps Build Artifact Binary Parsers @ |4 "

(# Target Processor Include paths (-1} 2 &8 38 &
# Optimization
(# Warnings

"${workspace_loc/${ProjName}/src}"
"${workspace_loc;/${ProjName}/src/bsp}”
(£ Debugging "${warkspace_loci/${ProjNamel/src/lib}"
~ &% GNU RISC-V Cross Assembler
(# Preprocessor
# Includes
# Warnings
(# Miscellaneous
~v &% GNU RISC-V Cross C Compiler
(22 Preprocessor Include system paths (-isystem) &
(22 Includes
# Optimization
# Warnings

(# Miscellaneous
v &% GNU RISC-V Cross C Linker
(# General
(2 Libraries
(# Miscellaneous
~v B3 GNU RISC-V Cross Create Flash Image
(# General Include files (-include) L=
~v B4 GNU RISC-V Cross Create Listing
(# General
v % GNU RISC-V Cross Print Size
(# General

2.2.4 i & GNU RISC-V Cross C Linker

fic & “GNU RISC-V Cross C Linker > General > Script files (-T)” 1%,
ZIETIEC E “sections.lds”. “sections_xip.lds” = “sections_debug.lds”
>4 Gowin_PicoRV32 Flash #4:4%, 1k 2-7 FizR.

% Gowin_PicoRV32 1+t IPCore Generator T.HH “ITCM >
Boot Mode” %1

® 115 Boot Mode i%£#“MCU boot from external Flash and run in ITCM”
B “MCU boot and run in ITCM” &5, M|i%+ sections.lds /£ 4 Flash
B et #lin"${workspace_loc:/${ProjName}/src/sections.lds}"

® 15 Boot Mode i£#% “MCU boot and run in external Flash” &5,
% 4% sections_xip.lds /£y Flash & #45, {5

"${workspace_loc:/${ProjName}/src/sections_xip.lds}"

® 1% Boot Mode % #“MCU boot from external Flash and run in ITCM”
¢ “MCU boot and run in ITCM” ¥£30, J HPATRAAELL L, Wik
#£ sections_debug.lds {E4 Flash % #5245, 40
"${workspace_loc:/${ProjName}/src/sections_debug.lds}"

IPUG910-1.5 11(20)




2 A TR AR 2.2 B E YA TR

& 2-7 it E GNU RISC-V Cross C Linker

& Tool Settings &) Toolchains [ Devices # Build Steps Build Artifact Binary Parsers @ | *

@ Target Processor Script files (-T) @ ID \\3
# Optimization
# Warnings
(# Debugging
v B GNU RISC-V Cross Assembler
(# Preprocessor
(# Includes
(# Warnings
(# Miscellaneous
v B GNU RISC-V Cross C Compiler
@ Preprocessor
(# Includes

# Optimization
# Warnings
(# Miscellaneous
~ B GNU RISC-V Craoss C Linker
(# General
(# Libraries
# Miscellaneous
v B GNU RISC-V Cross Create Flash Image

(# General
v B GNU RISC-V Cross Create Listing
(# General
¥ & GNU RISC-V Cross Print Size [ Do not use standard start files (-nostartfiles)
@ General [ Do not use default libraries (-nodefaultlibs)
Mo startup or default libs (-nostdlib)
Remave unused sections (-Xlinker --gc-sections)
[ Print removed sections (-Xlinker --print-gc-sections)
£ >

[JOmit all symbol information (-s)

® Do not use standard start files (-nostartfiles)
W BRI AME AR R 3 SCF . Gowin_PicoRV32 A2 I H 52 LI
AR, DR Z0H iR i 01
® Do not use default libraries (-nodefaultlibs)
BCE RN AME IR HE R SR, RA YL RSB a RS, fHER
Gt 5P 06 T (40 -static-libgee B-shared-libgee) K ZUm& . 15 15 Fi A
WS B0, BRARE H-nostartfiles. i i% 2% 1 fE 43 45 B mememp.
memset. memcpy A memmove i .
® No startup or default libs (-nostdlib)
- EEREIN I I FRAHE R R SR B SO B .
- BHARMEEICHE, KA MR E R E R IS s s s, IR HIRE R
G [ 3P 1) %6 T (4n-static-libgec B-shared-libgee) itk 2
- THRHNZIET
® Remove unused sections (-Xlinker —gc-sections)
- AT R A TR B
- ZGEI A g iR P AL 1 B 1Y -ffunction-sections fll-fdata-sections
MET, AT LEIE RN I R A Y s ORI AR B, 3k — B IR/ 1 Size
® Print removed sections (-Xlinker —print-gc-sections)
27t J5 Remove unused sections (-Xlinker —gc-sections)i, 1] PLEE

IPUG910-1.5 12(20)




2 AT AR

22 REE M TR

JEAZEIN, 2 PRI S R AR AR BR BB A2 FK S Anie s A B FR B
® Omit all symbol informations (-s)
AT AT ST N R BT A 555 R AN E AL B
!
ZiIMETF S “Do not use standard start files (-nostartfiles)” 1 “Remove unused sections
(-Xlinker --gc-sections)” /NI .

2.2.5 it  GNU RISC-V Cross Create Flash Image

IPUG910-1.5

fic ® “GNU RISC-V Cross Create Flash Image > General” 3£, %%
DL E, WK 2-8 fis.

LA T K TRASHE RN, ZIsBiicE, W HR:
® Output file format (-O)& Wi, #4448 Raw binary
® it JT/3 Section: -j .text &I
® i#JT)3 Section: -j .data &

WERAE AT TRE A B 5 SR, 1R ek A2 S i 31 5 2 R B,
NI FE7E Other sections () INIX L& F & LB, 41 Gowin_PicoRV32 H &
XA B

® .irgsec
® .|dsec
® _.btsec

2-8 it E GNU RISC-V Cross Create Flash Image

& Tool Settings %) Toolchains M Devices # Build Steps Build Artifact Binary Parsers @ | ¢ *

(2 Target Processor Output file format (-0) |Raw binary ks
# Optimization
# Warnings
(£ Debugging

[ Section: -j text
[ Section: -j .data

v B3 GNU RISC-V Cross Assembler Other sections () £ =5 & ¥
2 Includes ldsec
# Warnings btsec

# Miscellaneous
v B3 GNU RISC-V Cross C Compiler
(2 Preprocessor
2 Includes
# Optimization
# Warnings
(& Miscellaneous
~ 3 GNU RISC-V Cross C Linker
# General
# Libraries
# Miscellaneous
w &3 GNU RISC-V Cross Create Flash Image
(2 General
~ 3 GNU RISC-V Cross Create Listing
# General
~ 3 GNU RISC-V Cross Print Size
# General

Ll
v

Other flags

13(20)




2 A TR AR 2.3 it TR

2.3 wiFEHTIE

% Gowin_PicoRV32 figiff it IP Core Generator T.J2&H “ITCM >
Boot Mode” L& /30, & X config.h J53Z%% & X BUILD_MODE:
® MCU bootand runin ITCM : #define BUILD_MODE BUILD_LOAD
® MCU boot from external Flash and run in ITCM: #define BUILD_MODE
BUILD_BURN
® MCU boot and run in external Flash: #define BUILD _MODE
BUILD_XIP
FERCRAF THEIEDCE . A BB RS G, fmiFRa 1R, B
THF“Build”( & ) “Build All” (=), B3¢ A4 “ Project > Build Project”
g “Project > Build All”, 2w 1%/~ A9 2t Binary 30, Wi 2-9 B
N
B 2-9 wmiFpGTIi2

{Hp workspace riscy - C/C++ - picorv32_demo/sre/main.c - GOWIN MCU Designer

Ele Edit Source Refactor Navigate Sea ect Run Window Help

Hmid [ B-f-@in|SiBlie-O-® - {IR@MEH - 2o
[ Project Explorer 52 5% =0 [Emanc 2 =g

3 2203 test 000
v (5 picorv32_demo

il Includes
= Debug
v [ src

T AHBREGDEMO Re;
AHBREGDEMO_BA

PICO_AHBREGDEM
) (anonymous)
@ WBREGDEMO Reg,,

< >

B Console £ oG A -&IME-N-=0O

15:04:59 Build Finished (took 95.252ms)
v

<

Writable Smart Insert | 3:1 ] 5]

2.4 T#
56 Gowin_PicoRV32 MR ik it gt fa, WA gmPE it N &7,
iES#% IPUG913, Gowin PicoRV32 #1f | # = F .

2.5 R ELEI

5% Gowin_PicoRV32 #4-4mFE ¥eit Binary 34 N, A
R BT AL, AT PO KRS Olimex 17 B4 (B¢ RiscV &
A G IR AT 2% T ST RE I FLAR A LAY ), R T vt

Gowin_PicoRV32 # i imfE, fE:
® Il E WIS

IPUG910-1.5 14(20)
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2 A TR AR 2.5 ALK

B E R Flash BEB:52
i B A A A T
PR )] 1158

o AN MR
2.5.1 EBHHFRRFR

£ Project Explorer #L&h, 1&#E 451 T, fd7ikdE “Properties >
C/C++ Build > Settings > Tool Settings > Debugging > Debug level” 3£,
ZIEGIACE, WK 2-10 Frs.
[l 2-10 fit ® Debugging
& Tool Settings %) Toolchains M Devices . Build Steps Build Artifact Binary ! | *

@ Target Processor Debug level Maximum (-g3) ~
& Optimization

(8 Warnings Debug format Toolchain default  ~
(2 Debugging [ Generate prof information (-p)
w B3 GNU RISC-V Cross Assembler []Generate gprof information (-pg)
(£ Preprocessor Cther debugging flags
(2 Includes

(# Warnings
(2 Miscellaneous
w By GNU RISC-V Cross C Compiler
(% Preprocessor
(2 Includes
(% Optimization
(£ Warnings
(2 Miscellaneous
~ By GNU RISC-V Cross C Linker
(2 General
(& Libraries
(2 Miscellaneous
~ By GNU RISC-V Cross Create Flash Image
(2 General
~ By GNU RISC-V Cross Create Listing
(2 General
~ BBy GNU RISC-V Cross Print Size
(2 General

Debug level FL &, 5L EI:
None: L% HACE

Minimal (-g1): /D IRSEHACE
Default (-g): BRIATHKE R E
Maximum (-g3): & KRR E

IPUG910-1.5 15(20)




2 AT AR

2.5 PAFAE LMK

2.5.2 BgEiFR Flash #3588

1EL R Gowin_PicoRV32 # P4 e s ihif, 135 5 W BT il Flash
43 sections_debug.lds”, Flash #E#:45 BL B 775155 % 2.2.4 [iLE GNU
RISC-V Cross C Linker.

1% “GNU RISC-V Cross C Linker > General > Script files (-T)”, &
NS {workspace_loc:/${ProjName}/src/sections_debug.lds}”.

SERECE AR Flash #8485, 2% 2.3 SR TR, S i
AR FE R T Binary SCEFS

FEREAT TR, E2% 2.4 Ta, BB Mg iE ¥t Binary
A

2.5.3 BB BT

IPUG910-1.5

WAL “Run > Debug Configurations > GDB OpenOCD
Debugging” &5, 4 g “New” TN, #7280 LAE BRI E
I, 2-11 Bk
B 2-11 3 AR FE R

W Debug Configurations X

Create, manage, and run configurations

| = 3 - Configure launch settings from this dialog:
type filter text - Press the 'New' button to create a configuration of the selected type.
[E] C/C++ Application =| - Press the ‘Duplicate’ button to copy the selected configuration.
[€] C/C++ Attach to Applicati
E / ach To App eamon 3 - Press the 'Delete’ button to remove the selected configuration.
[£] C/C++ Postmortem Debugger
[€] C/C++ Remote Application :#:-} - Press the 'Filter' button to configure filtering options.
[£] GDEB Hardware Debugging - Edit or view an existing configuration by selecting it.
[2] GDB OpenOCD Dehuanina
[€] GDB PyOCD Deby New
[£] GDB QEMU Deb Duplicate igure launch perspective settings from the 'Perspectives’ preference page.
[£] GDB SEGGER J-Li Delete

= Launch Group

Filter matched 10 of 10 items

e
'\?,' Debug Clase

RS A RRIE DT, AL E Main. Debugger. Startup Z5ifiiE
TR

BCE Main IZTF

P “Main” &I, BB 217 THEK Project Al C/C++ Application 4%
I, Wil 2-12 PR

16(20)




2 A TR AR 2.5 ALK

& 2-12 it & Main &Ik

Main . %% Debugger| = Startup| &~ Source| [C] Commen| 2., SVD Path

Project:
|picor\r32_demo Browse...
C/C++ Application:
| Debug\picorv32_demo.elf
Variables... Search Project... Browse...

Build (if required) befare launching
Build Configuration: | Select Automatically

() Enable auto build
(® Use workspace settings

() Disable auto build

Configure Workspace Settings...

Bc & Debugger i£INF

1%£# “Debugger” %Ik, ALE OpenOCD F1 GDB &1, il 2-13
ﬁﬁ}j_‘—\‘o

2-13 fit E Debugger i£1-F

Main | %% Debugger . B+ Startup | &~ Source | [C] Common| &, SVD Path
OpenOCD Setup

A
Start OpenOCD locally
Executable path: |${openocd_path}j’${openo:d_executab|e} Browse... | |Vanables...
Actual executable: |,.-’undeﬁnedpathfopenocd.exe
(to change it use the global or workspace preferences pages or the project properties page)
GDB port:
Telnet port:
Tel port:
Config options: -f board/openocd_olmx.cfg
Allocate console for OpenOCD Allocate console for the telnet connection
GDB Client Setup
Start GDB session
Executable name: |${crossipreﬁx}gdb${crossisufﬁx} Browse... | Variables...
Actual executable: |riscv-none-embed-gdb |
Other options: | |
Commands: set mem inaccessible-by-default off
set arch riscwirv32
Iset remotetimeout 250
Remote Target
Host name or IP address: | localhost
Port number: 3333
[JForce thread list update on suspend v

® OpenOCD Config options i% i &
ZIETHEC B N “-f board/openocd_olmx.cfg”, T& & R E 2SR &

IPUG910-1.5
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2 AT AR 2.5 PAFAE LMK

A, GMD FAFBRIAE A Olimex 1/ FH. 4%
® GDB Commands & Tifid &

- set mem inaccessible-by-default off

- setarch riscv:rv32 (455 RiscV 545 44H44))

- set remotetimeout 250 ([ 1 R SGE D
BL ¥ Startup %N

A “Startup” &R, BLEPATELIARKEFED, W& 2-14 iR,
[# 2-14 B2 E Startup EIRF

[El Main [ %¥ Debugger | = Startup % Source| [C] Common| %, SVD Path

Initialization Commands ~

[ Initial Reset. Type:

[JEnable ARM semihosting

Load Symbols and Executable

] Load symbols

(@ Use project binary: picorv32_demo.elf
() Use file:

orkspa File System
Symbols offset (hex): l:l
[ Load executable
(®) Use project binary:  picorv32_demo.elf
() Use file: orkspa File S m

Executable offset (hex): l:l

Run/Restart Commands
[1Pre-run/Restart reset Type: (always executed at Restart)

[]Set program counter at (hex):

Set breakpoint at:

[ Continue

® |nitialization Commands & Tific &

- TP/ Initial Reset i3, Type XA & N “init”, AT LRI,
CIRDN=EIE/ KRRl Lo
- i&2%M] Enable ARM semihosting i%£i, Gowin_PicoRV32 3 1%
Dhfe
® Load Symbols and Executable g &
- 1HJT)E Load symbols &1, i “Use project binary”
- 15JT/3 Load executable £, 1+ “Use project binary” &5
® Runtime Options &M &
B 5 Debug in RAM &1, $uAT7E LR AR, 2BV (44w F2 % 11 Binary
A, B R ITCM
® Run/Restart Commands % i fic &

IPUG910-1.5 18(20)




2 AT AR 2.5 PAFAE LMK

- 1iJFJa Pre-run/Restart reset T, Type KAFLE N “halt”, AT
FELR AW, WLl s
- 157TJ5 set breakpoint at T, FLEA “main”, PATIEL R,
A LA E BI4E main 32 eR 8 58— 2 Th R A7 B BB T A
- i5JT)3 Continue &I, AT 7ELL T, 7T LA H Zhig 17 2 W b #
I
2.5.4 EEIIA I ERF
L Olimex il 417 785 il o
T RS Olimex Al 4% (5X RiscV 54 4L A FE 2% AT X FF
) F At 7 L2
Olimex A1 & 2%, %M Olimex arm-usb-tiny-h, B84 :
https://www.olimex.com/Products/ARM/JTAG/ARM-USB-TINY-H/
Olimex A EA AN K2R I E, WHZ% SUG549, GOWIN
MCU Designer /{1 /'75%.

¥ Olimex 4304/ B 221 TDI. TDO. TMS. TCK 5| % 85k JTAG
B O 5T kW iER:, VREF 5| iER: 3.3V, 4/6/8/.../120 1) GND 5] il
TERE— AT,

2.5.5 BENEETEL AR

fch THAZ Debug “ % ™7, PUTHAEL IR, iR aHE.
® RMX: WLIAE C MM, WwEN &, BITRFE,
o FEIX: AILLETE I AT 5% B R AR B 4
O I GIEAIX: WLATEE MG ATEMEEL ITCM P8 R4 5l IE AT

(364
® K. T LASHITE AR, Y,
it A BT b T R B

Gowin_PicoRV32 &AL RiscV 5522 My kb3 2%, ozl &
GEVETH RIS, AN SRR R S R R T S R

R, 24 IF AT AL, 3 AR AL T 8RS (AT RSB AT,
7 B AT, AR IEAT BT A AE A, HE SR E R,
MCU JE34 0 57 41 b 775K

01 SR TS 3 o T A R BT R AR, U A A e T b R
(AR LA A T A, TR HE B LB ATIRAS

#il T AAS “Resume”, 7T LUMEARFHE N JELHEITIRGS, W% 185
7 5, T (R LB APIRAS . EMIR S T, AR B & H P 7% SR, MCU
PRAT R T AT BR K, 3B AT P T AT R e BT A N ERAS,
AT LAZE T A EE R P T B R W R AR B Rk,

IPUG910-1.5 19(20)
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3 ZH it

3 SEWI

Gowin_PicoRV32 32#F GMD (Ei A FicA: V1.2) BRI Z
Fyort, W EERRIN T 2T
...\ref_design\MCU_RefDesign\picorv32_demo
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